
April 2007 Volume 29 No 4

1

DENVER APPLE PI

C A LE N D A R
SIG and Help Meetings are held at

The Consolidated Mutual
Water  District Building

12700 W 27th Avenue
Lakewood
7 to 9 pm

unless otherwise noted


MEETING DATES SET FOR

APRIL - DEC 2007

Apr 17 Tues Mac SIG
April 25 Wed Help SIG
May 15 Tues Mac SIG
May 23 Wed Help SIG
June 12 2nd Tues Mac SIG
June 27 Wed Help SIG
July 10 2nd Tues Mac SIG
July 25 Wed Help SIG
Aug 14 2nd Tues Mac SIG
Aug 22 Wed Help SIG
Sept 18 3rd Tues Mac SIG
Sept 26 Wed Help SIG
Oct 16 Tues Mac SIG
Oct 24 Wed Help SIG
Nov 20 Tues Mac SIG
Nov 28 Wed Help SIG
Dec 18 Tues Party
Dec 26 ? Wed Help SIG
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DAPI sends condolences to Annette
Rau whose mother passed away April
18, 2007.

Late Seed Publication this
month

Your editor has been out of the
state to join family for the birth of
our grandson. Additionally, your
editor managed to break an ankle.
Doctor said to elevate my leg as
much as possible. It’s awkward
composing this newsletter with my
foot in the air. Sorry it’s late and I
hope you enjoy the effort!

MEETING NOTES

M AY E LECTION OF D E N V E R
APPLE PI OFFICERS
As a volunteer organization, it is
vital that we continue to have
input from all members to be able
to keep our group active and
progressive. Thanks to all
members who also attend our
meetings and offer suggestions for
programs, activities, ideas and fun.
Members who willingly share their
knowledge by giving a program
are greatly appreciated. It means
we can all learn from each other.
We often get help from each other,
too.

The following offices are all open
for nominations. If you are
interested in volunteering or wish
more information about any of the
duties, please do not hesitate to
ask someone on the Board! We'll
try to have an email ballot for
those receiving the PDF newsletter
and a printed one for the printed-
mailed version. All ballots will be
counted at the May Mac SIG, May
15th.

The present positions are held by
the following:
President - Larry Fagan
Vice President (Mac SIG) - Tom
King
Vice President (Help SIG) - Jim
Awalt
Treasurer - Larry Knowles
Membership - Sheila Warner
Secretary - Elissa McAlear
Appointees: Diana Forest - Web
master & John Nelson
   Joyce Etherton - Seed Editor



April 2007 Volume 29 No 4

2

   Wes Schalamon - Apple II
Librarian



The March and April Mac SIG
meetings were recorded by Larry
Knowles. At each of these
meetings, Larry Fagan presented
very useful information about
using OS 10.4 Tiger. If you would
like a DVD of the proceedings,
please let Elissa  know.

Plans are being made for our
annual picnic in July. A location
other than Corwina Park is being
considered because of the winding
mountain road and lack of a
building shelter—last year it
rained. Any suggestions? We need
horseshoe pits, croquet space, and
barbeque & toilet facilities.
elissamc@comcast.net.



EVEN MORE ON WIRELESS
CONNECTIONS
Used with permission of
Tony Pizza, Mac/Appleholics
Anonymous

Prospective member Steve Heir
commented on last month’s article
about protecting a wireless
network. He points out that it is a
fallacy to “Turn off broadcasting
your SSID” to improve security.

Steve goes on to say, “In a ‘perfect’
world (when there are no other
802.11 devices in the area then) it is
true that a passive scan of an area
would fail to reveal the network in
question – however in reality other
‘authorized’ 802.11 entities are
communicating with the access
point/router and as such the
router/AP is broadcasting its SSID
(to those units). An example
would be leaving your laptop
running in your living room and
having its  mail  program
periodically check mail. This
would result  in periodic
transmissions of the SSID even
though it had been disabled within
the AP/router configuration. This

would allow a passive scan (the
ideal method for a hacker) to
identify your network.”

Steve is correct. Turning off the
SSID is not the perfect solution.
The article said “most passersby
won’t know that you have a
network and as a result, won’t try
to access it.” It’s true that a
determined hacker, with enough
time, could learn the SSID, and
could learn the password when an
authorized user accessed the
network. Using MAC addresses
also is not complete protection, “it
might be another obstacle for a
casual hacker – but anyone in the
know would be able to quickly
and easily clone the sniffed MAC
address of a functional unit.”

Don’t lose too much sleep though.
Practically, a hacker would have to
be within range of your wireless
signal. If you live in the typical
residential neighborhood, there
might be some nearby teenagers
who could be trying to steal
bandwidth. If you make it harder,
they’ll find an easier target. Steve
agrees that the older WEP security
can be cracked relatively easy, and
that WPA is much preferred. So
read those and instructions and
learn how to use it.



FREE ELECTRONIC
POSTCARDS FROM APPLE

Send a message for any occasion
for free!
For those not aware, the Mac.com
website offers free electronic
greeting cards to anyone who
wants to take advantage. No .Mac
subscription needed.

http://www.mac.com/WebObject
s/iCards.woa/2/wa/default?aff=c
onsumer&cty=US&lang=en&ident
ifier=ObPm3Pevqz4yCh3w&wosid
=dws4obq4TpPVItsTtpIbKM

Apple calls these electronic
postcards "iCards". If you are a

.Mac member, there are additional
features like using your own
photos and quick addressing from
your contacts list.

It's fun. It only takes a minute to
compose and send. Reach out and
touch someone today!


MAC OS 10.4 – TIGER
Presentation by Larry Fagan
Written by Joyce Etherton

The OS 10.4 – Tiger builds on top
of the successes of previous OS X
versions. As David Pogue says (the
author of MAC OS X: Missing
M a n u a l  [ISBN-13:  978-0-596-
00941-0]) this has UNIX the
industrial-strength, rock-solid OS
that is decades old and polished by
generations of programmers and
allows us all to go for months or
years without a crash. OS 10.4
itself provides us with many
special features that, combined
with the various applications we
use, make our Macs just the best
thing going. There are so many
things we can do that mastering,
or even just minoring in some,
makes the effort worthwhile.

At our MacSIG meeting Larry
Fagan presented some of the new
features to us and also referenced
another manual, 100 Simplified OS
X Tips and Tricks [ISBN: 978-0-
7645-7699-7].

Larry Fagan at the controls

With a blank screen (or where
blank screen is visible), hold down
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Control Key and Mouse and you
get the following:

New Folder
New Burn Folder
Get Info

Change Desktop Background
Show View Options

Automator> Create workflow
Enable Folder Actions
Configure Folder Actions
Stuffit >(Many options)

Customizing the Tool Bar
 In the Finder window,  pull

down the GO menu, and
select Computer.

 In the View menu, select
Customize Tool Bar and
drag your favorite items to
the Computer Tool Bar
(not the Finder Tool Bar).
To get rid of them, drag
them off the Tool Bar and
they go Poof!

Special Function Keys

F1, F2, F3 – Sticky keys

Can be used as Universal Access
keys—for those with visual,
hearing or keyboard difficulties,
including using the mouse. In the
Finder, select System  Preferences,
select the Universal Access (the
light switch with the Apple logo
on it). Sticky Keys lets you press
multiple-key shortcuts (including
Shift, Option, Control, Open
Apple) simultaneously.

F4 – clipboard, paste

F5 – Find and Replace

F6 – use for shortcuts

F7  Spelling and Grammar

Option F8 – Create Macros

Control F8 – Start Classic, Open
Classic Preferences, Apple Menu

Items (see following screen shoot
of apple Menu items just by
clicking Control F8:

F9 – gives you split screen. Move
mouse to select page you work on.

Apple F9 -- gives you double
brackets that you can type your
bracketed information into or
inserts hyperlinks.

F10 –  darkens screen surrounding
document you’re working with.
Toggle the switch so only
document is highlighted. Must
click on document (or photo) to
edit.

F11 – clears screen so you can
bring another document up
without closing one you’re using –
it’s a toggle switch, so you can
clear screen, click F11 again and
bring back old document.

Option F11 – adds Project and
Property sidebars for your
document organization tasks.

F12 – Opens widgets.

F13, F14, F15 – Assign your own
special functions.

Character Palette
Go to Apple menu System
Preferences>International>On
Language tab, select English. On
Input Menu: check Character
Palette, Keyboard viewer and at
bottom of page check Show Input
menu in menu bar.

The  American flag  will now show
on the menu bar at the top of your
screen.

Then, to get the Character Palette,
click on the American flag and
select Keyboard Viewer which will
show on the desktop. At the
bottom of this pop-up window
select the font you want to use;
e.g., Zaft Dingbats. Then hold down
the option key on your keyboard  and
see the new characters available in
the Zaft Dingbats fonts. Click on

the selected new character and
create some new characters for
your document:  For example:

∑œ™πæ©≈√µ∞

There are so many choices
available to make our Macs easy
and meaningful to our specific
needs that referencing either of the
manuals is really a complete way
to learn. Selecting the specific
manual for your specific operating
system provides the best help, of
course. Since each of us learns in
our own special way, one manual
might be more useful than
another, but each of the referenced
manuals is available in our library
and you may borrow it (call
Elissa).  Attending MacSIG
meetings also provides another
learning method and you can even
ask questions!!



LET DISK UTILITY DO ITS
THING
By Matt@Smalldog.com

In Mac OS 10.4 Tiger a new feature
was added to Disk Utility that
writes random data to the free
space on your hard drive.  "Who
cares?" you ask.  Well, if you work
with sensitive information of any
kind, and delete it at any point,
that data is still on your drive even
though it does not appear to be
available.  Any technically inclined
miscreant with physical access to
your machine can recover that
data if they had to...they'd just
need a good bit of time, patience,
and the  r ight  sof tware
(http://subrosasoft.com/OSXSoft
ware/index.php?main_page=prod
uct_info&products_id=1).

By writing random data over the
free space 35 times, Disk Utility's
"Erase Free Space" function
effectively makes it impossible to
recover deleted files.  However, if
you're curious and want to try it
out, it's going to take quite some
time--start it before bed and wake
up the next morning to a finished
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process.  If you cancel it, or force
quit, you'll be left with a drive
with almost no free space.  A
frantic search of your hard drive
for the gigantic file will turn up
nothing, and you'll be mad.  Don't
fret--just take one file, any file, put
it in the trash and empty it.  Your
drive will then show the correct
amount of free space.
You can also empty the trash
securely to begin with.  From the
Finder menu, select Secure Empty
Trash.  It takes forever, but the files
will be completely destroyed.



TAKE CONTROL OF BOOKING
A CHEAP AIRLINE TICKET
A young man, Sam Sellers, has
written a book, available in print
or readable online (ebook) for
finding the lowest possible fare as
well as using flyer miles, credit
cards that provide flight discounts
and recommended methods for
t r a c k i n g  d e a l s .  Appendices
provide links to major airline
home pages.
MyMac has given this book 5 out
of 5 points.  The ebook covers both
domestic and international travel
originating in the US. It can be
updated online for either the print
book or ebook prices. You can see
a free 29-page PDF sample at web
page shown below. The book was
first published 11-Aug-06.

ISBN: 1-933671-17-3

HTTP://WWW.TAKECONTROLBOOKS.
COM/AIRLINE-

APPLE DELAYS RELEASE
OF A LEOPARD OS 10.5
Thanks to John Nelson for this report

Apple says in a press
release dated April 12, 2007
that the much anticipated
release of Leopard has been
delayed.  Now, reports from

NEW APPLE RETAIL
STORE OPENING

Store Address
8401 Park Meadows Center Dr.
Littleton, CO 80124

Store Hours
Mon-Thur: 10 to 9
Fri-Sat: 9:30 to 9:30
Sun: 11:00. to 6:00.
Grand Opening April 21

FOR SALE
hp color laserjet printer 2550N –
USB or ethernet.  Printer still using
some starter cartridges: very low
number of pages printed. New
yellow cartridge; will need red &
blue cartridges soon. Software,
added paper tray and network
capability but no box.  $200 OBO.
Call Addis at (303) 232-4533

OS 10.4 (TIGER) ROTATE A
SINGLE PDF PAGE IN PREVIEW
In OS 10.4 Preview, selecting
“Rotate” from the Tools menu
rotates every page of a PDF left or
right. However, if you want to
rotate only one page, you can hold
down Option while selecting
Tools>Rotate, and this will rotate
the current page only.

Apple say that a “near
final” version will be
distributed to developers in
June 2007 at WWDC
(Worldwide Developers
Conference) for testing and
final release will be
available in October 2007.
Apparently, engineers and
quality assurance staffers

D E - M Y S T I F Y I N G  SOME
INTERNET TERMINOLOGY

Tammy Hanson

At our March 20, 2007 meeting,
Tammy Hanson used a handout to
illustrate how our computers
access the internet. It is attached to
this newsletter. Tammy suggested
researching various Internet
Service Providers (ISPs) to
determine what you want, what is
available and how much it will
cost you. There are significant cost
variations, of course, and your
operating system may limit your
choices. A few browsers aren’t
supported for newer Macintosh
operating systems. But the ones
that do, including Mozilla, Firefox
and Safari, are convenient to use.
Refer to Tammy’s convenient
summary for a quick overview of
internet terminology.  (See next
page.)

Tammy Hanson

working on Leopard needed
to switch projects to ensure
the iPhone arrives as
planned. Hope this doesn’t
ruin anyone’s plans for
purchasing a new computer
this spring with this new
operating system included.
There’s always Christmas.
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De-mystifying some Internet terminology (I hope!)

Computer
Operating
System
(Mac) ISP Connection Browser

ISP
email

Internet
email

Computer
email

OS 9 AOL Broadband
Internet
Explorer AOL Yahoo

Outlook
Express

OS 9.2.2 Comcast DSL Netscape Comcast Netscape Mail
OS X Quest Dial-up iCab Quest gMail Thunderbird
OS 10.0
Cheetah FasterMac Satellite Mozilla FasterMac Hotmail
OS 10.1 Puma Earthlink Firefox Earthlink Excite
OS 10.2 Jaguar Safari
OS 10.3
Panther
OS 10.4 Tiger

To access the internet from your computer, you are paying someone for service (ISP), as well as the type of connection used (DSL).
An ISP may require a minimum Operating System (OS).

A Browser is how you surf the web, or get from place to place. You need a Browser to work with your Operating System.

Most ISPs provide you with one or more email addresses as part of the service. You can access this email by downloading it to your
Mac (Computer email). [Often this deletes the email from your ISP mailbox.]

You visit the Web Site of your ISP, log in and read your email online – these emails stay in your online mailbox and are not on your
Mac. This option usually gives you the greatest spam filters and ease of multiple sorting and deleting.

You can sign up for additional email addresses from an Internet email provider, usually free of charge. This option lets you keep
your email address no matter how often you change ISPs!

To identify your operating system for OS 9.2.2 and below, simply use the numbers. OS 10 may be referred to as the number (OS
10.x.x), as OS X, or as its actual name (Jaguar, Panther, Tiger, etc.)which can be confusing. If you’re not sure of its “name” or if you
need precision, refer to your OS as its number: e.g., 10.3.9.
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DENVER APPLE PI MEMBERSHIP INFORMATION
Denver Apple Pi (DAPI) is an Apple Computer Users Group, not affiliated with Apple Computer, Inc. The SEED is an independent publication not affiliated
or otherwise associated with or sponsored or sanctioned by Apple Computer, Inc. The opinions, statements, positions and views stated herein are those of the
author(s) or publisher and are not intended to be the opinions, statements, positions or views of Apple Computer, Inc. Articles, stories, and other items in the
SEED may be copied or used by other clubs or groups as long as credit is given to Denver Apple Pi and the author of the article. On reprints, please also
include the date or volume number from the SEED.
MEMBER BENEFITS INCLUDE: MONTHLY MEETINGS: information, new product announcements, door prizes when available, share ideas with
other members, and copy programs from the Disk Libraries. PROGRAM LIBRARIES: Over 900 public domain programs, GS Library on 3.5" disks or on a
100 MB ZIP disk, Mac disks available in HD, ZIP and CD formats.
MEMBERSHIP DUES are $20.00 per year for a monthly hard copy of the SEED and $15.00 per year for a monthly pdf copy. Fill in the form below or ask
for an application to send with your check to the Club mailing address:
DENVER APPLE PI, 6501 Welch Ct, Arvada CO 80004-2223
Elissa McAlear:  call 303.421.8714 for information about Apple II, GS and Mac. Email elissamc@comcast.net
Our website is: <www.denverapplepi.com>

Macintosh SIG meets the THIRD Tuesday of the month, 7:00 to 9:00 p.m.
Troubleshooter Group meets the FOURTH Wednesday of each month, 7:00 to 9:00 p.m.
SEED articles should be mailed to jjetherton@comcst.net, subject: "SEED Article"

Membership Form:  Date                                                           Denver Apple Pi Officers, May '06-May '07
Renewal                          New                         Change                  President Larry Fagan
Name                                                                                              VP (Help) Jim Awalt
Address                                                                                           Vic President (Mac) Tom King
City                                                                                                Secretary Elissa McAlear
Phone                                                                                              Treasurer Larry Knowles
Email                                                                                               Membership Chair Sheila Warner
Kind of Computer: Apple II          GS        Mac          OS              

For further information, call Elissa 303.421.8714
Appointees: Wes Schalamon (Librarian), Joyce Etherton (SEED Editor), Diane Forest (Webmaster)

Denver Apple Pi
6501 Welch Court
Arvada, CO 80004-2223

Please check your address label for the expiration date.
If due, RENEW or JOIN today.
If there is an error or if you have questions,
Call Elissa, 303.421.8714

FIRST CLASS MAIL – Dated Material

Return Service Requested


